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About vRealize Network Insight Installation
Guide

The vRealize Network Insight Installation Guide is intended for administrators or specialists
responsible for installing vRealize Network Insight.

Intended Audience

This information is intended for administrators or specialists responsible for installing vRealize
Network Insight. The information is written for experienced virtual machine administrators who
are familiar with enterprise management applications and datacenter operations.

VMware, Inc.



Preparing for Installation

Before you install vRealize Network Insight, prepare the deployment environment to meet the
system requirements.

This chapter includes the following topics:
m  System Recommendations and Requirements

m  Supported Products and Versions

System Recommendations and Requirements

For optimum performance, you must match the minimum recommendations for the deployment.

Recommendations for the Platform Deployment

Table 1-1. Specifications for Platform Brick Size

Cores required Cores required Cores required
Brick Size for 2.1 GHz CPU for 2.3 GHz CPU for 2.6 GHz CPU RAM Disk
Medium 10 9 8 32 GB 1TB
Large 15 14 12 48 GB 1TB
Extra Large 20 18 16 64 GB 2TB

Note

m  The reservation for the CPU speed and RAM for each node must be 100% of the value
specified above.

m  To match your setup to all the specifications, you might have to add the resources (RAM,
Disk, CPU). See https://kb.vmware.com/s/article/53550 and Increase the Brick Size of your
Setup.
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Table 1-2. Non-Cluster Deployment - Maximum Capacity

Number of VMs Flows per Day Total Flows Flow Planning
Brick Size (in thousands) (in millions) (in millions) (in millions)
Medium 4K ™ 4M 2M
Large 6K 2M 8M 4M

Table 1-3. Non-Cluster Deployment - Maximum Capacity for VMware SD-WAN

Number of Edges Flows per Day Total Flows

Brick Size (in thousands) (in millions) (in millions)
Medium 2K ™ 4M
Large 2K 2M 8M

Note

m  The count of VMs includes the templates on the vCenter as well.
m  Total Flows is the maximum count of flows the system can store for the retention period.

m  Flow Planning is the total flows for which the system can perform security planning.

Table 1-4. Cluster Deployment - Maximum Capacity

Number of
Edges for
Number of VMware SD-
VMs Flows per Day Total Flows Flow Planning WAN
Brick Size Cluster Size (in thousands) (in millions) (in millions) (in millions) (in thousands)
Large 3 10K 2M 8M 4M 4K
Extra Large 3 18K 6M 24M 4M 6K
Extra Large 5 30K 10M 40M 4M 10K
Extra Large 10 100K 15M 55M 4M 10K

Note

m  The count of VMs includes the templates on the vCenter as well.
m  Cluster size is the total number of nodes in the cluster.
m  Total Flows is the count of flows in the system for the retention period.

m  The query to determine the Total Flows is count of flows in last 31 days, assuming the
retention period as 31 days.

m  Flow Planning is the total flows for which the system can perform security planning.

VMware, Inc.
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Recommendation for the Collector Deployment

Table 1-5. Specifications for Collector Brick Size

Cores required Cores required Cores required
Brick Size for 2.1 GHz CPU for 2.3 GHz CPU for 2.6 GHz CPU RAM Disk
Medium 5 5 4 12 GB 200 GB
Large 10 9 8 16 GB 200 GB
Extra Large 10 9 8 24 GB 200 GB

Note The reservation for the CPU speed and RAM for each node must be 100% of the value
specified above.

Table 1-6. Collector Deployment - Maximum Capacity

Number of Edges for

Number of VMs Flows per Day Flow count in 4 days VMware SD-WAN
Collector Size (in thousands) (in millions) (in millions) (in thousands)
Medium 4K 2.5M 3.25M 4K
Large 10K 5M 6.5M 6K
Extra Large 20K 10M 13M 10K

Note

m  The count of VMs includes the templates on the vCenter as well.

m For a single deployment with more than one collector, the limitation on the total flows across
collectors is based on the capacity of the platform.

Other Requirements and Considerations

= The maximum time skew between the platform nodes has to be lesser than 30 seconds.

m  The availability of the NTP service is critical to system operations. Ensure that you do not
reboot the platform node or the collector node when the NTP service is not available.

. When the existing compute resources are completely used by the other processes on the
platform, vRealize Network Insight crashes and does not recover automatically. If the services
fail to recover, reboot the platform node.

m |f the network latency between platform node and upgrade server is greater than 500ms, the
vRealize Network Insight upgrade might encounter an error. So, the network latency must be
less than 500ms.

m  The recommended disk latency for optimal performance is up to 5ms. If the disk latency is
greater than 5ms, the system performance degrades.

m  The recommended disk IOPS is 7500.

VMware, Inc. 8
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Supported Web Browser

m  Google Chrome: The latest two versions.

m  Mozilla Firefox: The latest two versions.

Recommendations to Support High Availability

You can customize vSphere HA options to enable vSphere high availability.
m  Host Failure - Restart VMs

m  Host Isolation- Disabled

m  Guest not heartbeating- Disabled

Privileges

Privileges Required for Data Sources
m  Privileges required to configure and use IPFIX
m  vCenter Server Credentials with privileges:
m Distributed Switch: Modify
m  dvPort group: Modify

m  The predefined roles in the vCenter server must have the following privileges assigned at
root level that need to be propagated to the children roles:

m  System.Anonymous
m  System.Read

= System.View

m global.settings

To know more about roles in vCenter, see Using Roles to Assign Privileges section in
vSphere Security guide.

m  Privileges required for NSX Manager Data Provider
m  NSX Manager Data Provider requires the Enterprise role.

m |f Central CLl is enabled, then the system admin credentials are required for NSX Manager
Data Provider.

VMware, Inc.
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m  User privileges required on Cisco switches for metrics collection

m  VRealize Network Insight is capable of collecting metric data via SNMP as well as
configuration via SSH from Cisco Switches. Cisco Switches UCS platform requires the use
of both SSH and API for collection.

Table 1-7.

Type of data

Configuration Data

Metric Data

System Ports

User Privileges

Read-Only

SNMP read-only

SNMPvV2 read-only SNMP community

SNMPvV3 read-only

Following is the list of ports required for the vRealize Network Insight inbound communication:

Ports for the Platform Cluster Setup

Table 1-8.

Source

SSH client

Client Web-
Browser
and VvRNI
Collector

VMware, Inc.

Target

Platform

Platform

Port

22

443

Protocol

SSH

HTTPS

Purpose

CLI or host
access

UI/API
access and
communicat
jon with
VRNI
Collector

Sensitive

No

Yes

SSL

Yes

Yes

Authenticati
on

User/
Password or
SSH key-
based
authenticati
on

SSL channel
encrypted
with 2048b
RSA key
based SHA2
cert (or
User
configured
custom
cert).
Collector to
Platform
messages
on this
channel also
encrypted
further with
HMAC.

10
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Table 1-8. (continued)

Source

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

VMware, Inc.

Target

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Platform

Port

2181

2888

3000

3888

5432

8020

8025

8030

Protocol

HTTP

HTTP

HTTP

HTTP

jdbc

TCP/RPC

HTTP

HTTP

Purpose

Communicat
ion between
zookeeper
servers on
other nodes
(in case of
cluster).
And stores
metdata
information(
znode data)

Used to
connect to
zookeeper
leader

Used for
email
notifications

Used for
zookeeper
leader
election

Storing VM
configuratio
n data and
infra meta
data

Communicat
e between
other name
node(s) and
data nodes

Node
managers
use this port
to connect
to resource
manager

Used by
resource
manager to
schedule
the tasks

Sensitive

No

No

Yes

Yes

Yes

Yes

No

SSL

No

No

No

No

No

No

No

No

Authenticati
on
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Table 1-8. (continued)

Authenticati
Source Target Port Protocol Purpose Sensitive SSL on

Platform Platform 8032 HTTP The address  No No
of the
applications
manager
interface in
the RM

Platform Platform 8033 HTTP The address  No No
of the RM
admin
interface

Platform Platform 8042 HTTP Node No No
manager
web app
address

Platform Platform 8080 HTTP Serves Ul Yes No
requests

Platform Platform 8088 HTTP The HTTP No No
address of
the
Resource
Manager
web
application

Platform Platform 8480 TCP/RPC JournalNod No No
e HTTP
server

Platform Platform 8485 TCP/RPC HDFS No No
shared edits
data dir

Platform Platform 9090 HTTP Serves Yes Yes
requests (protected
from via nginx)
collector
and sends
commands
to collector

Platform Platform 9092 Binary over Port on Yes No
TCP which other
brokers
communicat
e

VMware, Inc. 12
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Table 1-8. (continued)

Source Target Port Protocol
Platform Platform 9200-9300 HTTP
Platform Platform 9300 HTTP
Platform Platform 30000:6553 TCP

5
Platform Platform 60000 IPC
Platform Platform 60010 HTTP

VMware, Inc.

Purpose

Serves
search
requests. ES
uses range
of ports to
listen, if
9200 is by it
uses next
port
available.

Serves
search
requests. ES
uses range
of ports to
listen, if
9200 is by it
uses next
port
available.

Ephemeral
ports range
used by
various
processes
to make the
TCP
connection
with the
other
processes

Used for
communicat
ion between
other hbase
primary and
region
servers

Used for
hbase web
Ul

Sensitive

Yes

Yes

No

Yes

No

Authenticati
SSL on

No

No

No

No

No

13
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Table 1-8. (continued)

Source Target Port
Platform Platform 60020
Platform Platform 4500-4510

Protocol

IPC

TCP

Ports for the Single Platform Setup

Table 1-9.

Source Target Port

SSH client Platform 22

Client Web-
Browser
and VRNI
Collector

Platform 443

VMware, Inc.

Protocol

SSH

HTTPS

Purpose Sensitive

Communicat Yes
ion between
hbase

primary and
region

server

Communicat  Yes
ion between
Foundation

DB servers
running on
different

platforms

Purpose Sensitive

CLI or host No
access

UI/API Yes
access and
communicat

ion with

VRNI

Collector

SSL

No

No

SSL

Yes

Yes

Authenticati
on

Authenticati
on

User/
Password or
SSH key-
based
authenticati
on

SSL channel
encrypted
with 2048b
RSA key
based SHA2
cert (or
User
configured
custom
cert).
Collector to
Platform
messages
on this
channel also
encrypted
further with
HMAC.
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Ports for the Collector Server

Table 1-10.
Source Target
SSH client Collector
VRNI Platform
Collector
Flow Collector
Forwarder
Flow Collector
Forwarder

VMware, Inc.

Port

22

443

UDP 2055

UDP 6343

Protocol

SSH

HTTPS

NetFlow/
IPFIX

sFlow

Purpose Sensitive SSL

CLI or host No Yes
access

Primary Yes Yes
communicat

ion channel

with

Platform

Flows from Yes No
target are

pushed to

this port

Flows from Yes No
target are

pushed to

this port

Authenticati
on

User/
Password or
SSH key-
based
authenticati
on

SSL channel
encrypted
with 2048b
RSA key
based SHA2
cert (or
User
configured
custom
cert).
Collector to
Platform
messages
on this
channel also
encrypted
further with
HMAC.
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Table 1-10. (continued)

Source Target
ESXi Host Collector
Dell OS10 Collector

Port

1991

50000

Protocol

Purpose

TCP Collecting

latency
measureme
nt of virtual

infrastructur

e, for
example:
latency
between
VvNIC to
pNIC, VTEP
to VTEP,
TEP to TEP,
and so on.

GRPC Receiving

buffer stats
telemetry
information
from Dell
OS10
devices

Network Communication Ports

Sensitive

No

No

Authenticati
on

The following table lists the ports and the protocols that are used for the network communication
in VRealize Network Insight.

You can also see the list of ports at https://ports.vmware.com/home/vRealize-Network-Insight.

Table 1-11.

Purpose

Communication
between the VMs
of vRealize Network
Insight

Services that require
Internet access

Communication
for miscellaneous
services configured

VMware, Inc.

From

Collector

Platform and
Collector

Platform

Platform and
Collector

To
Platform

Note The port must
be enabled for all
platforms.

svc.ni.vmware.com

support2.ni.vmware.c
om

reg.ni.vmware.com

LDAP server

SNMP server

DNS server

Port

443

443

389, 636

Configurable

53

Protocol

HTTPS

HTTPS

LDAP and LDAPS

SNMP

UbP
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Table 1-11. (continued)

Purpose

Communication with
AWS as a data
source

Communicate with
Telemetry service

Communication with
other data sources
within the data
center

VMware, Inc.

From

ESXi Hosts

ESXi Hosts

Collector

Browser

Collector

To

Syslog server
Collector

Collector
AWS(*.amazonaws.c

om)

Telemetry
URLhttps://
vcsa.vmware.com

Arista switches
Azure

Brocade switches
Check Point firewall
Cisco Nexus

Cisco UCS (Unified
Computing System)

Cisco Catalyst
switches

Cisco ACI Switches
Cisco APIC Controller
Dell switches

Dell OS10

VeloCloud

HP

Juniper Switches
Palo Alto Networks
VMware vSphere

VMware NSX - V (All
Component)

NSX-T Manager

VMware PKS API
Server

Port

Configurable

2055

1991

443

433

161 and 22

443

161 and 22

443

161 and 22

161, 22, and 443

161 and 22

161

161 and 443

161 and 22

50000

443, 2055

22

161 and 22

443

443

22 and 443

443

8443 and 9021

Protocol

TCP

HTTPS

HTTPS

SNMP and SSH

HTTPS

SNMP and SSH

HTTPS

SNMP and SSH

SNMP, SSH, and
HTTPS

SNMP and SSH

SNMP

HTTPS and SNMP

SNMP and SSH

TCP

HTTPS

SSH

SNMP and SSH

HTTPS

HTTPS

SSH and HTTPS

TCP

TCP
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Table 1-11. (continued)

Purpose

From

To Port
Kubernetes API 8443
Server

VvRealize Log Insight 443
Fortinet 443

FortiManager

Supported Products and Versions

vRealize Network Insight supports several products and versions.

Data Source

Amazon Web
Services
(Enterprise
License Only)

Avrista switches

Azure
Subscription

Brocade
Switches

Check Point
Firewall

Cisco ACI

Cisco ASA

Cisco Catalyst

Cisco Nexus

Cisco UCS
(Unified
Computing
System)

Dell switches

VMware, Inc.

Version/Model

Not Applicable

7050TX, 7250QX,
7050QX-32S, 7280SE-72

Not Applicable

VDX 6740, VDX 6940,
MLX, MLXe

Check Point R80, R80.10,
R80.20, R80.30

3.2

X Series with 0S 9.4

3000, 3750, 4500, 6000,
6500

3000, 5000, 6000, 7000,
9000

Series B blade servers,
Series C rack servers,
Chassis, Fabric interconnect

FORCE10 MXL 10, FORCE10
S6000, S4048, 79100,
S4810, PowerConnect
8024, Dell OS10

Connection Protocol

HTTPS

SSH, SNMP

HTTPS

SSH, SNMP

HTTPS, SSH

HTTPS (to APIC controller)
SNMP (to APIC controller and

ACI switches)
SSH, SNMP

SSH, SNMP

SSH, SNMP

UCS Manager: HTTPS
UCS Fabric: SSH, SNMP

SSH, SNMP

Protocol

TCP

HTTPS

HTTPS

Permissions/Privileges

See the Add Datasources section
in the User Guide.

See the Add Datasources section
in the User Guide.

See the Add Datasources section
in the User Guide.

See the Add Datasources section
in the User Guide.

See the Add Datasources section
in the User Guide.

See the Add Datasources section
in the User Guide.

See the Add Datasources section
in the User Guide.

See the Add Datasources section
in the User Guide.

Read only user
Read only SNMP user

Read only user
Read only SNMP user

Read only user
Read only SNMP user
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Data Source

Fortinet
FortiManager

F5 BIG - IP

HP

Huawei Cloud
Engine

Infoblox

Juniper Switches

Kubernetes

OpenShift

Palo Alto
Networks

ServiceNow

VMware SD-
WAN

VMware, Inc.

Version/Model

6.0.1

12.1.2 and later

HP Virtual Connect
Manager 4.41, HP OneView
3.0

6800, 7800, 8800

Infoblox NIOS version 8.0,
8.1,8.2

EX3300, QFX 51xx Series
(JunOS v12 & v15, without
QFabric)

B 112 on NSX-T 2.3.1
B 112 on NSX-T 2.3.2
B 113 on NSX-T 2.3.2

3.1

Panorama 7.0.x, 7.1, 8.x, 9.0

London

VeloCloud Orchestrator
and Edge Version 3.3.1and
later

Connection Protocol

HTTPS

HTTPS, SSH, SNMP

HP OneView 3.0: HTTPS

HP Virtual Connect Manager
4.41: SSH

SSH, SNMP

HTTPS

Netconf, SSH, SNMP

HTTPS

HTTPS

HTTPS

HTTPS

HTTPS

Permissions/Privileges

The user must have:

B  at least the Restricted User
role with access to all ADOMs
and policy packages.

m  the rpc-permit read access
enabled from Command Line
Interface (CLI).

The user must have at least the
guest role. Also, TMSH must be
enabled and must have access to
all partitions. F5 BIG-IP supports
both routing and load balancing.

Read only user

Read only user
Read only SNMP user

Read only user with API Interface
access

Read-only permissions for DNS
object types as follows:

m  Permission Type - DNS

m  Resource - A Records, DNS
Zones, DNS Views

Read only user
Read only SNMP user

User must have cluster admin
role with read permissions.

See the Add Datasources section
in the User Guide.

User must have admin role with
XML API access. For details, see
the Palo Alto Networks section in
the vRealize Network Insight User
Guide.

User must have admin role

User must have Account Role
with any of the following
permission:

m  Superuser
m  Standard Admin

m  Customer Support
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Data Source

VMC on AWS -
vCenter

VMC on AWS -
NSX Manager

VMware ldentity
Manager

VMware PKS

VMware NSX
Manager
(VMware NSX-V)

VMware NSX-T
Manager

VMware, Inc.

Version/Model Connection Protocol

M8 and later HTTPS

Note Only NSX-T based
VMware Cloud on AWS
SDDCs are supported.

M8 and later HTTPS

Note Only NSX-T based
VMware Cloud on AWS
SDDCs are supported.

3.3 and later HTTPS

Supported Versions

Supported Versions SSH, HTTPS

2.4. HTTPS
For additional supported

version, see Supported

Versions

Permissions/Privileges

User must have the following
permission:

m  Cloud Administrator: To add

data source and enable IPFIX.

User must have any of the

following permission:

m  Org Member.Administrator:
To add data source and
enable IPFIX.

m Org
Member.Administrator.NSX
Cloud Admin: To add data
source and enable IPFIX.

m  Org Member.VMware Cloud
on AWS (all role): To add

data source and enable IPFIX.

m  Org Member.NSX Cloud
Auditor: To add data source.

User must have admin role.

User must have cluster
admin role permissions -

pks.clusters.admin.

See the Edge Data Collection
section in the vRealize Network
Insight User Guide.

Read only user

20
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Data Source
VMware vRealize

Log Insight

VMware vSphere

Note

Version/Model

Supported Versions

Supported Versions

For IPFIX, VMware ESXi

version needed:

m 55 Update 2 (Build
2068190) and above

m 6.0 Update 1b (Build
3380124) and above

m  VMware VDS 5.5 and
above

Note VMware tools should
be installed on all the

VMs in the data center to
identify the VM to VM path.

Connection Protocol

HTTPS

HTTPS

Permissions/Privileges

API user with permissions to
install, configure, and manage the
content pack

Read only user

Privileges required to configure
and use IPFIX

vCenter Server Credentials with
privileges:

Distributed Switch: Modify
dvPort group: Modify

The predefined roles in the
vCenter server must have the
following privileges assigned at
root level that need to be
propagated to the children roles:

System.Anonymous
System.Read
System.View

global.settings

m  The supported operating systems for Cisco ASA, ACI, Catalyst, and Nexus devices is iOS/NX-
OS; and for Cisco UCS is UCSM version.

m  The supported operation system for Arista is Arista EOS.

VMware, Inc.
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You can deploy vRealize Network Insight using vSphere Web client or vSphere Windows native
client.

Note After you successfully deploy vRealize Network Insight Platform OVA, verify whether the
given static IP is set on vCenter Server.

To automate installation, configuration, upgrade, patch, configuration management, drift
remediation and health from within a single pane of glass, you can use vRealize Suite Lifecycle
Manager. If you are a new user, click here to install vRealize Suite Lifecycle Manager. This
provides the IT Managers of Cloud admin resources to focus on business-critical initiatives, while
improving time to value (TTV), reliability and consistency.

You can also install and upgradevRealize Network Insight by using vRealize Suite Lifecycle
Manager. For more information, see the vRealize Suite Lifecycle Manager Installation, Upgrade,
and Management Guide.

This chapter includes the following topics:

m  Installation Workflow

m  Deploying vRealize Network Insight Platform OVA

m Activating the License

m  Generate a Shared Secret

m  Setting up Network Insight Collector (OVA)

m  Setting up Network Insight Collector (AMI) in AWS for VMware SD-WAN

m  Deploy Additional Collector to an Existing Setup

Installation Workflow

To install vRealize Network Insight, you install the platform OVA, activate the license, generate a
shared secret, and setup collector OVA.

VMware, Inc. 22
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Installing vRealize Network Insight

Install Platform OVA
(Import in vCenter Server)

Open https://<Platform IP Address=
and activate license

Generate Shared Secret
and Setup Proxy OVA

Log into vRealize Network Insight
and add Data sources

A simplified deployment diagram of vRealize Network Insight is as follows:

VMware, Inc.
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Browser
(Chrome or Firefox)

vRealize Network Insight

Platform / Platform Cluster VM

vRealize Network Insight

Collector VM Physical Flow Collector
(Netflow, sFlow) data source

All Data sources
to collect config and Netflow from Physical Router
matric data and Switches

Deploying vRealize Network Insight Platform OVA
You can import the vRealize Network Insight Platform OVA to your vCenter Server.

Note Deployment of vRealize Network Insight Platform OVA on the VMC SDDC is not
supported.

Deployment using vSphere Web Client
You can deploy vRealize Network Insight using vSphere Web Client.

Procedure

1 Right-click the Datacenter where you want to install the appliance and select Deploy OVF
Template.

VMware, Inc. 24
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0 N o u b~ W
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13
14

15

16

Enter the URL to download and install the OVA package or browse to select the source
location of the OV A package.

Enter the OVA name. Select the destination folder for deployment.

Select a host or a cluster or a resource pool where you want to run the deployed template.
Verify the OVF template details.

Read the End User License Agreement and click Accept.

Select a deployment configuration. Click Next.

Select the location to store the files for the deployed template. Select Thin Provision as the
Virtual Disk format. Select the datastore or the datastore clusters where you want to store
the files. Click Next.

Select the network that the deployed VM will use.

The selected network should allow the appliance to reach out to Internet for support and
upgrade.

To customize the template for the deployment, you will have to manually configure the
appliance using the VM console. Click Next.

Verify the configuration details and click Finish.

Increase the Brick Size of your Setup to match the system recommendations and
requirements.

Once the platform is installed, start the VM and launch the console.

Log in with the console credential that you see on the screen and run the setup command.
Create the password for the support login and change the password for the consoleuser.
Note

m  Your password must contain a minimum of 6 characters. A single quote (') is not allowed.

m  You must change the support and consoleuser password periodically to comply with your
organization policy.

Enter the following details to configure the network:

a IPv4 Address: Second reserved static IP address

b Netmask: Subnet mask for the above static IP

c Default Gateway: Default gateway of your network

d DNS : DNS server of your environment

Note For multiple DNS servers, ensure that they are separated by space.

e Domain Search List : The domain that needs to be appended for dns lookups

f  Enter y to save the configuration.
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17 Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start
if NTP time is out of sync.

Note For multiple NTP servers, ensure that they are separated by commas.

18 (Optional) To configure Web Proxy, enter y.
19 All the services are verified.

20 Add additional disk space based on your setup requirement. See https://kb.vmware.com/s/
article/53550.

Deployment Using vSphere Windows Native Client

You can deploy vRealize Network Insight using vSphere Windows native client.

Note VRealize Network Insight 5.2 is the last release that supports deployment of OVA using
vSphere Windows Native Client. Starting from 5.3 release, you can continue to use vSphere Web
Client to deploy vRealize Network Insight OVA.

Procedure

1 Click File > Deploy OVF Template.

2 Enter the URL to download and install the OVA package from the internet or browse to select
the source location of the OVA package on your computer.

Click Next and verify the OVF template details.

Read the End-User License Agreement and click Accept.

Provide a name and specify the location for the deployed template. Click Next.
Select the Deployment Configuration.

Select a Host/Cluster where you want to run the deployed template.

Select the Resource Pool in which you want to deploy this template.
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Select a destination storage for the VM files. Click Next.

10 Specify the format in which you want to store the virtual disks. Select Thin Provision as the
virtual disk format. Click Next.

11 Specify the network that the deployed template should use. Map the network from OVA to
your inventory.

12 Customize the template for the deployment. Provide the shared secret that was generated
on the onboarding page. You will have to manually configure the appliance using the VM
console. Click Next.

13 Verify all the configuration data. Check Power on after deployment. Click Finish.

14 Increase the Brick Size of your Setup to match the System Recommendations and
Requirements.
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Once the Collector OVA is installed, start the VM and launch the console.

Log in with the console credential that you see on the screen and run the setup command.
Create the password for the support login and change the password for the consoleuser.
Note

m  Your password must contain a minimum of 6 characters. A single quote (') is not allowed.

m  You must change the support and consoleuser password periodically to comply with your
organization policy.

Enter the following details to configure the network:

a IPv4 Address: Second reserved static IP address

b Netmask: Subnet mask for the above static IP

c Default Gateway: Default gateway of your network

d DNS : DNS server of your environment

Note For multiple DNS servers, ensure that they are separated by space.

e Domain Search List : The domain that needs to be appended for dns lookup.
f  Enter y to save the configuration.

Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start
if NTP time is out of sync.

Note For multiple NTP servers, ensure that they are separated by commas.
(Optional) To configure Web Proxy, enter y.

All the services are verified.

Add additional disk space based on your setup requirement. See https://kb.vmware.com/s/
article/53550.

Activating the License

After installing the vRealize Network Insight Platform OVA, open https.//<vRealize Network
Insight Platform IP address> in the Chrome Web browser.

Procedure

1
2

Enter the license key received in the welcome email.

For Ul admin (admin@local) user name, set the password.

Note Your password must be alphanumeric, with a minimum of 8 characters and a maximum
of 100 characters. Space between the characters is not allowed.
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3 Click Activate.

4 Add the vRealize Network Insight Collector after activating the license.

Generate a Shared Secret

You can generate and import the vRealize Network Insight collector virtual appliance.

Generate a shared secret and import the vRealize Network Insight collector virtual appliance:

Procedure
1 Log into the vRealize Network Insight UL.
2 Expand Infrastructure and Support and click Overview and Updates.
3 Scroll down and click Add Proxy VM.
The Add a new Network Insight Data Collector virtual appliance dialog appears.
4 Click Copy to copy the shared secret from the dialog and click Done.

You will require this during the deployment of vRealize Network Insight Collector OVA.

Setting up Network Insight Collector (OVA)

You can set up vRealize Network Insight collector by importing OVA to your vCenter server.

Follow the steps below to import the vRealize Network Insight collector OVA to your vCenter
Server.

Deployment Using vSphere Web Client

You can import the vRealize Network Insight Collector OV A using vSphere Web Client.

Procedure

1 Right-click the Datacenter where you want to install the appliance and select Deploy OVF
Template.

2 Enter the URL to download and install the OV A package from the internet or browse to select
the source location of OVA from your computer.

3 Provide a name and specify the location for the deployed template. Click Next.

4 Select a resource (host or a cluster) where you want to run the deployed template. Click
Next.

5 Verify all the details of the template. Click Next.

6 Read the End-User License Agreement and click Accept. Click Next.

7 Select a deployment configuration. Click Next.
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Select the location where you want to store the files for the deployed template. Specify the
format in which you want to store the virtual disks. Select Thin Provision as the virtual disk
format. Select the Datastore in which you want to install the files. Click Next.

Specify the destination network for the source network. Click Next.

Customize the template for the deployment. Provide the shared secret that was generated
from the Ul You will have to manually configure the appliance using the VM console. Click
Next.

Verify all the configuration data. Click Finish.

Once the Collector OVA is installed, start the VM and launch the console.

Log in with the console credential that you see on the screen and run the setup command.
Create the password for the support login and change the password for the consoleuser.
Note

m  Your password must contain a minimum of 6 characters. A single quote (') is not allowed.

m  You must change the support and consoleuser password periodically to comply with your
organization policy.

Enter the following details to configure the network:

a IPv4 Address: Second reserved static IP address

b Netmask: Subnet mask for the above static IP

c Default Gateway: Default gateway of your network

d DNS : DNS server of your environment

Note For multiple DNS servers, ensure that they are separated by space.

e Domain Search List : The domain that needs to be appended for dns lookups
f  Enter y to save the configuration.
Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start

if NTP time is out of sync.

Note For multiple NTP servers, ensure that they are separated by commas.
(Optional) To configure web proxy:

a Entery.

b Provide the web proxy details.

A check is made to see if the shared secret key has been configured. The collector is paired
with the corresponding platform. This may take few minutes.

All the services are verified.
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20 Click Finish, once Proxy Detected! message is displayed on the onboarding page. It will
redirect to the Login Page.

Deployment using vSphere Windows Native Client

You can import the vRealize Network Insight collector OVA using vSphere Windows native client.

Note VRealize Network Insight 5.2 is the last release that supports deployment of OVA using

vSphere Windows Native Client. Starting from 5.3 release, you can continue to use vSphere Web

Client to deploy vRealize Network Insight OVA.

Procedure

1 Click File > Deploy OVF Template.

2 Enter the URL to download and install the OVA package from the internet or browse to select
the source location of the OVA package on your computer.

Verify the OVF template details. Click Next.

Read the End-User License Agreement and click Accept. Click Next.

Provide a name and specify the location for the deployed template. Click Next.
Select a Deployment Configuration. Click Next.

Select a Host/Cluster where you want to run the deployed template. Click Next.

Select the Resource Pool in which you want to deploy this template. Click Next.
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Select a destination storage for the VM files. Click Next.

10 Specify the format in which you want to store the virtual disks. the Select Thin Provision as
the virtual disk format. Click Next.

11 Specify the network that the deployed template should use. Map the network from OVA to
your inventory.

12 Customize the template for the deployment. Provide the shared secret that was generated
on the onboarding page. You will have to manually configure the appliance using the VM
console. Click Next.

13 Verify all the configuration data. Check Power on after deployment. Click Finish.
14 Once the Collector OVA is installed, start the VM and launch the console.
15 Log in with the given console credentials. Run the setup command.
16 Create the password for the support login. Change the password for the consoleuser.
17 Enter the following details to configure the network:
a IPv4 Address: Second reserved static IP address
b Netmask: Subnet mask for the above static IP

c Default Gateway: Default gateway of your network
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d DNS : DNS server of your environment

Note For multiple DNS servers, ensure that they are separated by space.

e Domain Search List : The domain that needs to be appended for dns lookup.
f  Enter y to save the configuration.
18 Enter the NTP Sever and ensure that it can reached from the VM. The services will fail to start

if NTP time is out of sync.

Note For multiple NTP servers, ensure that they are separated by commas.
19 (Optional) To configure web proxy:

a Entery.

b Provide the web proxy details.

20 A check is made to see if the shared secret key has been configured. The collector is paired
with the corresponding platform. This may take few minutes.

21 All the services are verified.

22 Click Finish, once Proxy Detected! message is displayed on the onboarding page. It will
redirect to the Login Page.

Setting up Network Insight Collector (AMI) in AWS for
VMware SD-WAN

You can set up vRealize Network Insight collector for AWS by importing Amazon Machine Image
(AMI) to your AWS environment.

If your environment does not have a vCenter server, and you want to deploy your collector in a
cloud environment then you can deploy your collector in AWS.

Note Currently, vRealize Network Insight supports the collector deployment in AWS using AMI
only for VMware SD-WAN.

The procedure and task related to EC2 instances are documented in https://
docs.aws.amazon.com/efs/index.html.
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Procedure

1 Launch your EC2 instance using the VMware provided AMI in the Amazon EC2 console. For

procedure details, see Create Your EC2 Resources and Launch Your EC2 Instance topic in the

Amazon Elastic File System documentation.

Note When you Launch your EC2 instance in AWS, you must select the following:

Option Action

Instance type m4.xlarge (MEDIUM BRICK)

Network Select an appropriate network and subnet.
Storage Default Storage.

Tags As per customer Policies.

Security Group Allow Outbound to 0.0.0.0/0 for port 443 (or for

restricted rules, allow outbound for NI SaaS Prod FQDN
for port 443).

Key Select appropriate Key (SSH Login is enabled for the
AMI).
2 When your EC2 instance is in the running state, log in to your EC2 instance.
3 Login with the given console credentials. Run the setup command.

4 Create the password for the support login. Change the password for the consoleuser.

Note After you change the password, the network options will be skipped during setup CLI.

Proxy AMI does not support the following:
m |P change
m |Pv6

m  Web Proxy Configuration.

5 Enter the NTP Server and ensure that it can be reached from the VM. The services fail to sta
if the NTP time is out of sync.

Note For multiple NTP servers, ensure that they are separated by commas.

6 A checkis made to see if the shared secret key has been configured. The collector is paired
with the corresponding platform. This process can take few minutes.

7 All the services are verified.
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What to do next

Enable the flow collection from Edges to the collector you deployed in AWS. To enable the flow

collection, do the following:

Make the collector you deployed in AWS as a Non-VeloCloud Site. For details, contact
VMware support.

Deploy Additional Collector to an Existing Setup

You can add additional vRealize Network Insight collector to an existing setup.

Procedure

1
2

Log into the vRealize Network Insight Ul.

Expand Infrastructure and Support and click Overview and Updates.

Scroll down and click Add Proxy VM.

The Add a new Network Insight Data Collector virtual appliance dialog appears.
Click Copy to copy the shared secret from the dialog and click Done.

Follow the steps in section Setting up Network Insight Collector (OVA) in step 3.
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Accessing vRealize Network
Insight by using the Evaluation
License

vRealize Network Insight starts in the NSX assessment mode when you use the evaluation
license.

You can add a data source to vRealize Network Insight, analyze traffic flow, and generate

reports.

Note To switch to the Full Product mode, click Switch to Full Product Evaluation located in the
bottom right corner.

This chapter includes the following topics:
m  Add vCenter Server
m  Analyze Traffic Flows

m  Generate a Report

Add vCenter Server

You can add vCenter Servers as data source to vRealize Network Insight.

Multiple vCenter Servers can be added to vRealize Network Insight to start monitoring data.

Prerequisites

m  The predefined roles in the vCenter server must have the following privileges assigned at
root level that need to be propagated to the children roles:

= System.Anonymous
m  System.Read
m  System.View
= Global.Settings
m  Following vCenter Server privileges are required to configure and use IPFIX:
= Distributed switch: Modify and Port configuration operation

m dvPort group: Modify and Policy operation
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To know more about roles in vCenter, see Using Roles to Assign Privileges section in vSphere
Security guide.

Procedure
1 Click Add vCenter.

2 Click Add new source and customize the options.

Option Action

Collector VM Select a collector VM from the drop-down menu.

IP Address/FQDN Enter the IP address or fully qualified domain name of the vCenter Server.
Username Enter the user name with the following privileges:

m Distributed Switch: Modify
m  dvPort group: Modify

Password Enter the password for vRealize Network Insight software to access the
vCenter Server system.

3 Click Validate.

If the number of VMs discovered exceeds the capacity of the platform or a collector node or

both, the validation fails. You will not be allowed to add a data source until you increase the

brick size of the platform or create a cluster.

The specified capacity for each brick size with and without flows is as follows:

State of
Brick Size VMs Flows
Large 6k Enabled
Large 10k Disabled
Medium 3k Enabled
Medium 6k Disabled

4 Select Enable Netflow (IPFIX) on this vCenter to enable IPFIX.

For more information on IPFIX, see the Enabling IPFIX Configuration on VDS and DVPG
section in the User Guide.

Note If you enable IPFIX in both vCenter and VMware NSX Manager, vRealize Network

Insight automatically detects and removes flow redundancies by disabling IPFIX on few of the

DVPGs for the associated vCenter.

5 Add advanced data collection sources to your vCenter Server system.

6 Click Submit to add the vCenter Server system. The vCenter Server systems appear on the
homepage.
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35



Installing vRealize Network Insight

Analyze Traffic Flows
You can use vRealize Network Insight to analyze flows in your datacenter.

Prerequisites

At least two hours of data collection must occur before starting the flow analysis.

Procedure

1 Specify the scope of the analysis. For example, if you are interested in flows of all virtual
machines in a Cluster, select Cluster from the dropdown menu. You can alternately select all
virtual machines connected to a VLAN or VXLAN.

2 Select the entity name for which you want to analyze the flows.

3 Select the duration and click Analyze.

Generate a Report

You can generate a report of the flow assessment.

Prerequisites

Analyze traffic flows in the datacenter. For comprehensive reports, collect 24 hours of data
before the analysis.

Procedure
1 Inthe EVAL NSX Assessment Mode, click Generate Report in the Analyze Flows page.

2 Inthe Non EVAL Mode, on the Microsegmentation page, click Traffic Distribution > More
Options > Assesment Report.
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Planning to Scale up your
Deployment

If the VM count or the number of active flows in your setup are high or expected to grow, you
can increase the size of the platform or collector.

You can use the following architecture for better understanding of the platform and collector
distribution:

Platform Cluster

Platform VM Platform VM
1
Collector VM Collector VM
A A

vCenter vCenter
4k VMs 6k VMs

This chapter includes the following topics:

Platform VM

m  Planning to Scale up the Platform Cluster
m  Planning to Scale up the Collector

m Increase the Brick Size of your Setup

Planning to Scale up the Platform Cluster

You can scale up the platform cluster to meet the increasing load. Based on the load, you can
either scale up by increasing the brick size or creating or expanding a platform cluster. Three
LARGE platform bricks can be connected together to form a platform cluster. If a platform is of
LARGE Or EXTRA LARGE brick size, then you have to scale up by creating a platform cluster.

VMware, Inc.

37



Installing vRealize Network Insight

To decide platform brick size and number of platform bricks, see System Recommendations and
Requirements.

Note The platform cluster does not support the high availability configuration. All the platform
nodes need to be up and running for the cluster to work at optimal performance levels.

Scaling up Scenarios for the Platform Cluster
m  Scenario 1: Your platform is running 5000 VMs and 1.5 million active flows
Convert your platform MEDIUM tO LARGE. See Increase the Brick Size of your Setup.

m  Scenario 2 : Your platform is running a single LARGE node with 9000 VMs and 2 million active
flows

Add two more LARGE brick nodes to convert into 3-node LARGE brick cluster. See Expand
Clusters in the vRealize Network Insight User Guide.

m  Scenario 3 : Your platform is running a 3-node LARGE cluster with one or more colletors, 15000
VMs and 4 million active flows.

Convert your existing platform nodes from LARGE t0 EXTRA-LARGE. See Increase the Brick Size
of your Setup.

m  Scenario 4 : Your platform is running a 3-node EXTRA-LARGE cluster with one or more colletors,
25000 VMs and 8 million active flows.

Add two more EXTRA-LARGE brick nodes to convert into 5-node Extra-LARGE cluster. See
Expand Clusters in the vRealize Network Insight User Guide.

Planning to Scale up the Collector

The collector capacity is based on the brick size. The datasource that you can add to a collector
is depended on the capacity of the collector (VMs and flows).

See Table 1-6. Collector Deployment - Maximum Capacity. After a collector is of LARGE brick size,
you have to add more collectors. You can scale up each collector to EXTRA-LARGE Size.

You can add multiple datasources to a collector based on the supported collector capacity.
However, you cannot add same datasource to multiple collectors.
Scaling up Scenarios for the Collectors
m  Scenariol: 2000 VMs in a vCenter.
Install one medium collector VM. Add the vCenter to this collector. See Add vCenter Server.

m  Scenario 2: 1000 VMs in vCenterl and 2000 VMs in vCenter2 (all of them are in one data
center)

Install one medium collector VM. Add both vCenters to this collector. See Add vCenter
Server.
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Scenario 3: 1000 VMs in vCenter1 (data centerl) and 2000 VMs in vCenter2 (data center2)

Install one medium collector VM in each data center. Add vCenter1 to a collector VM in same
data center and Add vCenter2 to a collector VM in its data center. See Add vCenter Server.

Scenario 4: VM count exceeds 4000, active flows exceeds 2.5 Million.

Convert your collector VM from MEDTUM tO LARGE. See Increase the Brick Size of your Setup.
Scenario 5: 9,000 VMs in vCenter1 without flows (data center?).

Install one large collector VM. Add this vCenter to the collector. See Add vCenter Server.
Scenario 6: VM count is less than or equal to 10000, but the active flow exceeds 5 million.

Convert your collector VM from LARGE 10 EXTRA-LARGE. See Increase the Brick Size of your
Setup.

Scenario 8: Two vCenters, vCenterl has 10000 VMs and 9 million active flows, and vCenter2
has 10000 VMs and 4 million active flows.

Install one EXTRA-LARGE and one LARGE proxies. Add vCenterl to EXTRA-LARGE proxy and add
vCenter2 to LARGE pProxy.

Scenario 9: One vCenter that runs 10000 VMs and 9 million active flows.

Install one EXTRA-LARGE proxy and add the vCenter to the proxy.

Increase the Brick Size of your Setup

To match your requirements, you can change the brick size of your platform or the collector
appliance from MEDIUM tO LARGE Or LARGE tO EXTRA-LARGE.

VMware, Inc.
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Procedure

¢ Perform the steps that are relevant to your setup.

Option

For a single node platform or fresh
independent OVA

For a cluster platform

For a collector

VMware, Inc.

Description

Log in to vCenter.
Shutdown the platform VM.

Increase the disk, RAM, total vCPU and corresponding reservation of the
VM to match the target brick size. For more information, see the System
Recommendations and Requirements page.

Restart Platform VM.

Log in to vCenter.

Shutdown the platform VM in the reverse chronological order. For
example: Shut down from Node 3 to Node 1.

Increase the disk, RAM, total vCPU and corresponding reservation. For
more information, see the System Recommendations and Requirements.

Restart Platform VMs in the chronological order. For example: Restart
from Node 1to Node 3.

Log in to vCenter.
Shutdown the collector VM.

Increase the disk, RAM, total vCPU and corresponding reservation of the
VM to match the target brick size. For more information, see the System
Recommendations and Requirements page.

Restart the collector VM.
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Upgrading vRealize Network
Insight

You can upgrade your current vRealize Network Insight environment to the latest version.
Important points to consider before upgarde:

m After upgrade, vRealize Network Insight takes around 12 to 24 hours to process the data that
were in pipeline during the upgrade operation and reflect on the UL

m  VRealize Network Insight does not support rollback or product downgrade. You must take a
backup before you proceed to upgrade. For more information about the back up and restore
process, see the https://kb.vmware.com/s/article/55829 KB article.

m |n a cluster environment, you must perform the upgrade operation only on the platform 1
node.

m  After upgrading to vRealize Network Insight 5.1, some of the firewall rule IDs might change to
the new IDs returned by the VMware Cloud on AWS 1.9 API. If any VMware Cloud on AWS 1.8
firewall rules that are attached to the flows exists:

m the correct or respective VMware Cloud on AWS 1.9 firewall rules would be attached
immediately after upgrade for all active flows.

m the firewall rules would refer to non-existent rules for the flows whose period of inactivity

is greater than 24 hours prior to upgrading 1.8 to 1.9 version.

Note If issues such as upload failure or Ul failure come up while performing the centralized
upgrade, contact VMware support.

Migration to Foundation DB

To distribute configuration data across datastores in the cluster, vRealize Network Insight 5.1
replaces PostgreSQL to Foundation DB for storing the configuration data. This enables vRealize
Network Insight to:

m  reduce the load on platform 1 node
m avoid single point of failure
m improve resiliency

m  enhance performance
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m  share the disk uniformly across cluster nodes

The migration process automatically,

m  shuts down all services

m starts table to table migration from PostgreSQL to Foundation DB

m  displays the dynamic migration progress information on the platform 1 Ul

The migration time to move data from PostgreSQL to Foundation DB depends on the disk speed
and the node count (more nodes provides more Foundation DB write throughput)

The time taken to complete the migration process depends on the size of the database.

Setup Size Data Size Node Count Typical Migration Time
Small 20GB to 40GB 1node 1to 2 hours

Medium 60GB to 100GB 3 nodes 7 to 10 hours

Large One cloud setups 500GB 10 nodes cluster 15 to 20 hours

XL (Megatron) 1TB 10 node cluster 35 to 40 hours

Note that the migration happens as a part of vRealize Network Insight upgrade process. So, the
upgrade time might be longer, which you see on the screen during the process.

vRealize Network Insight provides the different modes of upgrade.
This chapter includes the following topics:

= Online Upgrade

m  Single-Click Offline Upgrade

m  CLIUpgrade

Online Upgrade
Whenever there is a new version of vRealize Network Insight available, you receive a notification.

Prerequisites

m  The upgrade steps might fail if there is insufficient space in the /tmp directory. Verify you
meet the following disk space requirements for platform and collector server:

= /tmp-6GB
m  /home -2 GB

= Verify you meet the following disk space requirement for platform server:
m /-6 GB (Only for the Platform1 node)

m  /var - 40 GB
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m  Verify you have the minimum bandwidth requirement of 500 KB/s to download the upgrade
bundle from the server. The Install and the Support page throws an error, if the download
bandwidth is not sufficient.

m  Ensure that all the nodes are online. If any node is inactive, you will not be allowed to trigger

the upgrade.

m  Take the snapshots of the VMs.

m  Note the following values to verify after migration:

Count of VMs

VM where Snapshot Count > O
Count of Firewall Rule

Count of Security Group

Count of NSX Firewall

Procedure

1 When an update is available, you see Update available message notification.

Note

2 Inthe Update Available message notification, click View details to view details of update.

If the update notification is not available, verify that both vRealize Network Insight
platform and collector VMs have connectivity to svc.ni.vmware.com on port 443 and
reg.ni.vmware.com on port 443 by running the show-connectivity-status command. If
this connectivity requires http proxy, configure it on each VM using the set-web-proxy
command. Ensure that the output contains upgrade connectivity status as passed.

File a support ticket and provide the service tag from the product Ul. The service tag is
shown under Settings > About.

Log into the appliance and run the show-connectivity-status command. Provide a
screenshot of the command output from each vRealize Network Insight platform and
collector VMs.

VRealize Network Insight Upgrade screen appears.

3 Read the Before you proceed instructions and click Continue.

4 Wait for the pre-checks to complete, which verifies:

the disk space, including the space required for migration
the version
the NTP sync status

the bandwidth
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You can see the approximate time required to complete the upgrade process (including the
migration duration) on your setup.

5 Click Install Now.

6 Once the upgrade process begins, the vRealize Network Insight Upgrade screen provides the
status of the upgrade process.

Note

If a node becomes inactive, the upgrade process does not continue. The upgrade will not
resume until the node becomes active again.

The platform1 becomes the upgrade server. If platform?1 is offline, then no other node is
upgraded.

Once the platforms are upgraded, you can resume your normal vRealize Network Insight
operations even though the collector upgrade happens in parallel. Until the upgrade
process is completely over, the Node Version Mismatch detected message is shown in
the Install and Support page.

After the services are upgraded, Nginx restarts to display the migration process. So, you
might not be able to access the Ul for a short period (one to two minutes).

vRealize Network Insight starts migrating data to Foundation database. On the Data
Migration Status screen, you see:

m the overall status

m  the elapsed time

the table by table status
m  the number of records migrated

For any issues, you can use the Export Migration logs option to share with the VMware
support team.

The PostgreSQL data on the collectors are also migrated to Foundation DB as part of
upgrade process. However, the collector migration status is not shown on the UI.

7 Upon the completion of upgrade process, you see the confirmation message.

All platforms and the collectors nodes are upgraded.

What to do next

m  Login to vRealize Network Insight and perform your tasks.

m  After two or three days, delete the snapshots to save the disk space.

Single-Click Offline Upgrade

vRealize Network Insight supports the single-click offline upgrade of the product from Release
3.7 and later.
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Prerequisites

The upgrade steps might fail if there is insufficient space in the /tmp directory. Verify you
meet the following disk space requirements for platform and collector server:

= /tmp-6GB
m  /home -2 GB

Verify you meet the following disk space requirement for platform server:
m  /-12 GB (Only for the Platform1 node)

m /var-40 GB

Note The bundle upload and the subsequent upgrade steps may fail if there is insufficient
space in the /tmp directory.

To avoid the Ul session timeout, go to Settings > System Configuration > User Session
Timeout and increase the User Session Timeout to at least 2 hours. After you change the
session timeout duration, you must log in again to the system.

Ensure that all the nodes are online. If any node is inactive, you will not be allowed to trigger
the upgrade.

Take the snapshots of the VMs.

Note the following values to verify after migration:
s Count of VMs

m VM where Snapshot Count > O

m  Count of Firewall Rule

m  Count of Security Group

m  Count of NSX Firewall

Procedure

1

Download the required upgrade bundle file from My VMware and save the update package in
your local disk.

Check and ensure that the MpssumM value of the downloaded bundle matches the Mmpssum value
specified in the VMware website.

On the Install and Support page, under Software version, select Click here.

VMware, Inc. 45


https://my.vmware.com/en/web/vmware/info/slug/infrastructure_operations_management/vmware_vrealize_network_insight/3_0

Installing vRealize Network Insight

4 Click Browse to select the file and click Upload.

When the upload is complete, vRealize Network Insight show the Bundle Upload Complete
message notification within 2-3 minutes and the bundle processing happens in the
background.

Note

m  Until the upload of the package happens, ensure that the session is not closed. If the
session ends, you have to restart the upload process.

m Do not refresh the page after bundle upload, until you see the Update Available
message notification.
5 Inthe Update Available message notification, click View details.
VRealize Network Insight Upgrade screen appears.
6 Read the Before you proceed instruction and click Continue.
7 Wait for the pre-checks to complete, which verifies:
m the disk space, including the space required for migration
m the version
m  the NTP sync status
m the bundle
8 Click Install Now.
You can see the approximate time required to complete the upgrade process on your setup.
9 Once the upgrade process begins, the vRealize Network Insight Upgrade screen provides the

status of the upgrade process.

Note

m |f a node becomes inactive, the upgrade process does not continue. The upgrade will not
resume until the node becomes active again.

m  The platform1 becomes the upgrade server. If platform1 is offline, then no other node is
upgraded.

m  Once the platforms are upgraded, you can resume your normal vRealize Network Insight
operations even though the collector upgrade happens in parallel. Until the upgrade
process is completely over, the Node Version Mismatch detected message is shown in
the Install and Support page.

m After the services are upgraded, Nginx restarts to display the migration process. So, you
might not be able to access the Ul for a short period (one to two minutes).
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m  VvRealize Network Insight starts migrating data to Foundation database. On the Data
Migration Status screen, you see:

m the overall status

m  the elapsed time

m the table by table status

m  the number of records migrated

For any issues, you can use the Export Migration logs option to share with the VMware
support team.

m  The PostgreSQL data on the collectors are also migrated to Foundation DB as part of
upgrade process. However, the collector migration status is not shown on the UL

10 Upon the completion of upgrade process, you see the confirmation message.

All platforms and the collectors nodes are upgraded.

What to do next
m  Login to vRealize Network Insight and perform your tasks.

m  After two or three days, delete the snapshots to save the disk space.

CLI Upgrade

Consider the CLI upgrade only if both online upgrade or single-click offline upgrade does not
work. You must upgrade Platform VMs before Collector VMs. However, you must contact
VMware Support before initiating Offline Upgrade using CLI.

In a cluster environment, you must perform the upgrade operation only from Platform 1 (P1) node
and the other Platform nodes in the cluster get upgraded automatically. But you must upgrade
each Collector individually.

Prerequisites

m  The upgrade steps might fail if there is insufficient space in the /tmp directory. Verify you
meet the following disk space requirements for platform and collector server:

m /tmp-6 GB
m  /home - 2 GB
m  /var - 40 GB

m  Ensure that all the nodes are online. If any node is inactive, you will not be allowed to trigger
the upgrade.

m  Take the snapshots of the VMs.
m  Note the following values to verify after migration:

m  Count of VMs
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s VM where Snapshot Count > O
m  Count of Firewall Rule
m  Count of Security Group

m Count of NSX Firewall

Procedure
1 Download the required upgrade bundle file from My VMware.

2 Check and ensure that the Mp5suM value of the downloaded bundle matches the Mp5suM value
specified in the VMware website.

3 Copy the upgrade bundle to vRealize Network Insight Platform 1 VM and all Collector VMs.

m  To copy the file from Linux VM to vRealize Network Insight VM, run command scp

<filename>.upgrade.bundle consoleuser@<IP Address vRNI VM>:~/.

m  To copy the file from Windows VM to vRealize Network Insight
VM, run command pscp -scp <SOURCE PATH>\<filename>.upgrade.bundle
consoleuser@<IP Address VRNI VM>:~/.

Note Use the pscp utility from https://the.earth.li/~sgtatham/putty/latest/w64/

pscp.exe.

4 Loginto the vRealize Network Insight Platform 1 through CLI using consoleuser and run the
following commands:

m package-installer copy --host localhost --user consoleuser --path /

home/consoleuser/<filename>.upgrade.bundle

m  package-installer upgrade --name <filename>.upgrade.bundle

Note You must perform the Platform upgrade first then start the Collector update.

5 Runthe package-installer upgrade command again after the setup is rebooted as part of
OS upgrade.

Important If you get an SSH session timeout error, you must check /var/log/arkin/
centralized upgrade.log to know if the reboot has already happened. If the reboot is
successful, you must run the package-installer upgrade command again.

6 Loginto each Collector node through CLI and perform the upgrade using the same
commands used for platform upgrade.

Note You can upgrade all the Collectors simultaneously.

7 Verify the upgraded version using the show-version command.
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Uninstall vRealize Network Insight

You must uninstall vRealize Network Insight through vSphere Web Client.

Procedure

1 If you can access the vRealize Network Insight web portal, do the following:
a Login to the vRealize Network Insight web portal.
b Go to Settings > Accounts and Datasources.
¢ Turn off and delete all datasources.

Deletion of the vCenter datasource removes IPFIX settings (if configured) on VDS.
Similarly deletion of the NSX Manager datasource removes IPFIX settings from NSX Flow
Monitor.

2 If you are unable to access the vRealize Network Insight web portal, do the following:

a If Netflow (IPFIX) is enabled on vCenter, remove vRealize Network Insight collector IP
from VDS/DVPG IPFIX settings. See Remove Collector IP When Netflow is Enabled in
vCenter.

b If IPFIX is enabled on NSX, remove vRealize Network Insight collector IP Flow Monitoring
settings. See Remove Collector IP When Netflow is Enabled in NSX.

c If Netflow is configured on physical switches to send Netflow to vRealize Network
Insight Netflow Collector, modify the configuration at switches to stop sending NetFlow
information.

3 If any specific firewall or routing rules are created to allow or route traffic to and from
vRealize Network Insight VMs, remove those firewall/routing rules.

4 For security reasons, clean up access credentials used to configure data sources in vRealize
Network Insight.

5 Shutdown and delete all vRealize Network Insight Collectors and Platform VMs.

Remove Collector IP When Netflow is Enabled in vCenter

If Netflow (IPFIX) is enabled in vCenter, use this procedure to remove vRealize Network Insight
Collector IP from Virtual Dedicated Server (VDS)/Distributed Virtual Port Group (DVPG) IPFIX
settings.
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Procedure

1
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8
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Log in to vSphere Web Client.

Go to Home > Networking.

In the left pane, select the VDS and click Configure > Edit.

In the Collector IP address field, remove vRealize Network Insight Collector IP details.
In the Collector Port field, remove the port details.

Click OK.

You must wait around two minutes before you move to the next step.

Select the DVPG of this VDS and click Configure > Policies > Edit.

In the Netflow field, select Disable from the drop-down.

Verify your settings and click Apply.

What to do next

Perform the steps again for each VDS and its DVPGs for which IPFIX is enabled to remove
VRealize Network Insight Collector IP.

Remove Collector IP When Netflow is Enabled in NSX

If Netflow (IPFIX) is enabled in NSX, use this procedure to remove vRealize Network Insight
(vRealize Network Insight ) Collector IP flow monitoring settings.

Procedure

1

N o u b~ W N

Log in to vSphere Web Client.

Click Home > Networking & Security > Tools > Flow Monitoring > Configuration.
In the Global Flow Collection Status, click Disable.

To disable the flow connection, click IPFIX.

In the IPFIX tab, select the Collector IP and click Delete.

If there are no more IPs left, then click Edit and clear Enable IPFIX Configuration check-box.

Click Save.
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